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EESSPPEECCÍÍFFIICCAA  

01. A vertical de um lugar: 
 
A) é materializada pelo fio de prumo. 
B) é definida fisicamente pela direção perpendicular 

à gravidade. 
C) não tem relação com a gravidade local. 
D) define o horizonte do observador. 
E) é materializada pelo círculo vertical de um 

teodolito. 
 

02. Conhecendo-se uma distância topográfica de 1,2 km e 
o comprimento gráfico correspondente de 12 cm, a 
escala da planta será: 
 
A) 1:1.000 
B) 1:500 
C) 1:2.000 
D) 1:10.000 
E) 1:5.000 

 

03. O balizamento é: 
 
A) a distância horizontal topográfica. 
B) o desnível entre dois pontos. 
C) a materialização do alinhamento entre dois 

pontos. 
D) a materialização de dois pontos no terreno. 
E) a materialização da vertical no terreno. 

 

04. No uso de trena para a medida direta de distância 
topográfica, manter a trena esticada evita o erro de: 
 
A) horizontalidade. 
B) refração atmosférica. 
C) esfericidade terrestre. 
D) catenária. 
E) comprimento. 

 

05. A declinação magnética em um ponto da superfície 
terrestre é o ângulo entre a direção norte-sul: 

 
A alternativa CORRETA é: 
 
A) e a direção leste-oeste magnética. 
B) e a direção leste-oeste verdadeira. 
C) e a direção oeste-leste verdadeira. 
D) e a direção oeste-leste verdadeira. 
E) e a direção norte-sul magnética. 

 

06. Em um nivelamento geométrico, a leitura do fio 
superior da régua foi de 2,012 m e a do fio médio de 
1,945 m. 

 
Nessas condições, é CORRETO afirmar que: 
 
A) A distância entre o nível e a régua é de 6,70  m. 
B) A distância entre o nível e a régua é de 13,40m. 
C) A distância entre o nível e a régua é de 28,40 m. 
D) A distância entre o nível e a régua é de 9,67 m. 
E) É impossível calcular a distância entre o nível e a 

régua por falta de dados. 
 

07. Em um levantamento planimétrico, com a finalidade 
de se obter a área de um terreno, o azimute de uma 
direção resultou em 313o 49’.  

 
Nessas condições, o rumo da referida direção é de: 

 
A) 43o 49’  SW 
B) 43o 49’  NW 
C) 46o 11’   SW 
D) 43o 49’    SE 
E) 46o 11’   NW 

 

08. Se o rumo magnético de uma direção for de 3o 20’ NE 
e a declinação magnética for de -10o 00’, então o valor 
do rumo VERDADEIRO dessa direção será de: 

 
A) 6o 40’ NW 
B) 6o 40’ SE 
C) 13o 20’ SE 
D) 6o 40’ NE 
E) 13o 20’ NE 

 

09. A e B são dois pontos consecutivos de uma poligonal. 
Sendo  que  as coordenadas do  ponto  A são  xA =  0,  
yA =  0, a distância medida entre os pontos A e B é  
de 50m, o azimute da direção AB  é 30o. Sabe-se 
ainda     que sen 30o = 0,50 e cos 30o = 0,87.  

 
Nessas condições, as coordenadas do ponto B são 
aproximadamente: 
 
A) XB = 43,5 m ; yB = 25,0 m 
B) XB = 25,0 m ; yB = 25,0 m 
C) XB = 43,5 m ; yB = 43,5 m 
D) XB = 25,0 m ; yB = 43,5 m 
E) XB = 43,5 m ; yB = 35,0 m 
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10. Para se transportar as coordenadas conhecidas de 
um ponto topográfico para o ponto topográfico 
seguinte de uma poligonal topográfica, basta que se 
tenham: 
 
A) as coordenadas do ponto conhecido e a distância 

entre os dois pontos. 
B) a distância entre os dois pontos. 
C) as coordenadas do ponto conhecido e a latitude 

local. 
D) as coordenadas do ponto conhecido e a longitude 

e latitude locais. 
E) as coordenadas do ponto conhecido e o azimute 

da direção entre os dois pontos. 
 

11. O azimute topográfico de uma direção AB  é o ângulo 
formado entre o alinhamento AB  e: 
 
A) a direção leste. 
B) a direção sul. 
C) a direção norte. 
D) a direção oeste. 
E) a direção do eixo secundário do teodolito. 

 
 
12. A origem da contagem das altitudes para o Brasil, 

está localizada no estado: 
 

A) de São Paulo. 
B) do Rio Grande do Sul. 
C) de Minas Gerais. 
D) de Santa Catarina. 
E) da Bahia. 

 

13. Assinale a alternativa CORRETA. 
 
A) Em uma montanha, as curvas de nível, em planta, 

de maior altitude, envolvem as curvas de nível de 
menor altitude. 

B) O maior declive de um terreno corresponde à 
maior compactação de curvas de nível. 

C) Curvas de nível afastadas entre si correspondem 
a um terreno fortemente inclinado. 

D) Em um mapa topográfico, o espaçamento entre 
curvas de nível independe da escala desse mapa. 

E) Em um mapa topográfico, a representação de um 
rio se faz de modo paralelo às curvas de nível. 

 

14. O desnível entre dois pontos topográficos A e B, 
( )ABh∆  no nivelamento trigonométrico, depende 
somente: 
 
I- do ângulo de inclinação α  da luneta, da leitura da 

mira (régua graduada) e da altura do teodolito em 
A. 

II- do ângulo de inclinação α  da luneta, da leitura na 
mira (régua graduada), da altura do teodolito em 

A e da distância topográfica entre os pontos A e 
B. 

III- do ângulo de inclinação α  da luneta, da leitura na 
mira (régua graduada), da altura do teodolito em 
A e da distância inclinada entre os pontos A e B. 

 
Está INCORRETA ou estão INCORRETAS: 

 
A) I,II e III. 
B) Somente I e II. 
C) Somente I e III. 
D) Somente II e III. 
E) Somente I. 

 

15. Os métodos de nivelamento, em ordem decrescente 
de precisão, são: 

 
 

A) trigonométrico, geométrico, barométrico. 
B) trigonométrico, barométrico, geométrico. 
C) barométrico, geométrico , trigonométrico. 
D) barométrico, trigonomérico, geométrico. 
E) geométrico, trigonométrico, barométrico. 

 
 
16. O comando para inserir blocos a uma distância 

definida ao longo de uma entidade de forma irregular 
é: 

 
A) ARRAY 
B) INSERT 
C) MEASURE 
D) PLACE 
E) BASE 

 

17. No comando ATTDEF (Atribute Definition), é 
CORRETO afirmar que os modos válidos são: 

 
A) INVISIBLE, CONSTANT, VERIFY, PRESET. 
B) INVISIBLE, CONSTANT, VERIFY, PREVIEW. 
C) VISIBLE, CONSTANT, VERIFY, PRESET. 
D) VISIBLE, CONSTANT, VERIFY, PREVIEW. 
E) INVISIBLE, CONSTANT, PRESET, PREVIEW. 

 

18. O comando para identificar o novo ponto de inserção 
de um bloco ou arquivo de desenho é: 

 
A) INPUT 
B) POINT 
C) BASE 
D) NEW 
E) VERTEX 
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19. Analise a figura: 
 

 
 
 
 

 
 

 
 
 
Para desenhar a reta BC o ângulo da coordenada 
polar deve ser: 
 
A) 40º 
B) -  40º 
C) 120º 
D)  140º 
E) - 140º 
 
 

20. Analise a figura: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Para desenhar a reta DE o ângulo da coordenada 
polar deve ser: 
 
A) 165º 
B) 160º 
C) 140º 
D) 35º 
E) -140º 

 
 
21. A seguir, são apresentadas algumas alternativas de 

seqüências de comandos que podem ser utilizados 
com o sistema MicroStation.  

 
Qual é a seqüência apropriada para acessar um 
arquivo existente no computador em que se está 
trabalhando: 

 
A) File > New...   
B) File > Save As... 
C) File > Open... 
D) File > Drawing Composition... 
E) File > URL...   

 
 
 
 
 
 

 
22. Quando se inicia um trabalho com o sistema 

MicroStation, um conjunto de parâmetros são 
assumidos para iniciar as variáveis ambientais. Dentre 
estas variáveis, temos a cor de fundo das janelas.  

 
Qual é a seqüência de comandos que se utiliza para 
acessar ao item que permite a alteração dessa 
variável? 

  
A) Tools > Standard 
B) Wokspace > Preferences... >  Drawing 
C) Element > Attributes 
D) Wokspace > Preferences... >  View Options 
E) Wokspace > Preferences... >  GUI Options  

 
 
23. A seguir, é apresentado o conjunto de ferramentas 

que permitem a representação de elementos lineares. 
Cada uma está sendo identificada por um número 
decimal.  

 
Se imaginarmos a operação para inserir com o mouse 
um conjunto de segmentos lineares conectados, qual 
alternativa está CORRETA? 

 

 
 
 
 
 
 
 
 

A) Recursos 2 e 4. 
B) Somente o recurso 1. 
C) Recursos 3 e 5 . 
D) Somente o recurso 4. 
E) Somente o recurso 5. 

 
 

24. A seguir, é apresentado o conjunto de ferramentas 
que permitem a inserção de elementos poligonais 
planos. Cada uma dessas ferramentas está sendo 
identificada por um número decimal.  

 
Se imaginarmos a operação para inserir com o mouse 
um triângulo, qual alternativa está CORRETA? 
 

 
 
 
 
 
 
 
 

A) Recursos 1 e 2. 
B) Recursos 2 e 3. 
C) Recursos 3 e 4 . 
D) Somente o recurso 4. 
E) Recursos 2 e 4. 

 
 
 

 1 2  3  4 5 

 1 2  3  4 
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25. Com a finalidade de dar algum destaque aos 
elementos gráficos de área, é comum se usar 
texturas, ou padrões (Patterns). Para isso, o sistema 
MicroStation tem um conjunto de ferramentas que 
permitem a inserção de diferentes tipos de texturas 
para preenchimento dos elementos de área. Suponha 
que se deseja produzir sobre um polígono fechado 
uma hachura linear simples (Hatch area).  

 
Se considerarmos as variáveis que precisam ser 
inicializadas para a inserção da hachura, qual das 
alternativas está CORRETA? 

 
A) espaçamento, ângulo, tolerância e método. 
B) escala, ângulo, tolerância e método. 
C) comprimento, ângulo, espaçamento e método. 
D) área, espaçamento, número de aresta e tole-

rância. 
E) alinhamento, tolerância, número de aresta e ân-

gulo. 
 
 
26. Analise as proposições: 
 

I- Um processador de texto é um programa de 
computador destinado a editar e a visualizar 
arquivos de texto. 

II- É possível a obtenção automática de memoriais 
descritivos utilizando-se somente um processador 
de texto. 

III- Um processador de texto pode gerar índices 
automáticos, fazer formatação condicional, contar 
palavras, localizar palavras, etc. 

IV- Existem vários processadores de textos, alguns 
deles gratuitos. 

 
Estão CORRETAS: 
 
A) Apenas I, II e IV. 
B) Apenas I, III e IV. 
C) Apenas I, II e III. 
D) Apenas I e III. 
E) Todas as afirmativas. 

 
 
27. Analise as proposições relativas a planilhas 

eletrônicas:  

I- Planilha eletrônica é um programa de computador 
que utiliza tabelas compostas de linhas e colunas 
para a realização de cálculos ou apresentação de 
dados. 

II- É possível identificar uma célula pelo nome da 
coluna seguido do nome da linha.  

III- A célula é o componente elementar de uma 
planilha eletrônica. 

IV- Uma fórmula define como pode ser calculado o 
valor de uma célula em uma planilha eletrônica. 

 

Está CORRETA ou estão CORRETAS: 

A) Apenas I. 
B) Apenas I, III e IV. 
C) Apenas I, II e III. 
D) Apenas I e II. 
E) Todas as proposições. 
 

28. Assinale a alternativa CORRETA considerando um 
projeto de uma linha de transmissão de energia 
elétrica: 

 
A) Não é necessário analisar a topografia da região, 

são considerados apenas os efeitos sobre o meio 
ambiente. 

B) Efetua-se um estudo planimétrico da região, 
visando a escolha do caminho mais curto, 
portanto o mais econômico. 

C) Analisa-se apenas a altimetria da região, visando 
a um estudo da viabilidade de condução dos 
cabos. 

D) Realiza-se inclusive uma análise plani-altimétrica 
da região. 

E) Os dados necessários para o projeto são obtidos 
através de cartas da região na escala 1:100.000. 

 
 
29. O símbolo padronizado para identificação de materiais 

apresentado na figura, representa: 
                                                                                                                   
                                                       
 
                             
                                         
                   

A) Poliestireno. 
B) Polipropileno. 
C) Vidro. 
D) Polietileno Tereftalato (PET). 
E) Plástico. 

 
 
30. A figura representa dados dispostos em uma planilha 

eletrônica.  
 

Escolha dentre as alternativas a que permite calcular 
a média entre as distâncias medidas:                                                
 

 
 
 
 
 
 
 
 
 

A) = SOMA(A1:A6)/6 
B) = SOMA(A2:A6)/5 
C) = A2+A3+A4+A5+A6/5 
D) = SOMA(A2:A6/5) 
E) = (A1+A2+A3+A4+A5+A6)/6 
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PPOORRTTUUGGUUÊÊSS  

TEXTO 
 

Câmbio facilita acordo com Paraguai, diz diretor de  
Itaipu 

 
“A valorização do real facilitará uma possível 

ajuda do governo brasileiro ao Paraguai, segundo o 
diretor-geral de Itaipu, Jorge Samek. Como o orçamento 
da hidrelétrica é calculado em dólar, o fortalecimento da 
moeda nacional poderia servir para fazer caixa e auxiliar 
o vizinho. A variação cambial, por outro lado, poderia 
ajudar na redução da tarifa de energia do Brasil. 

Samek participou ontem de uma audiência na 
Comissão de Relações Exteriores e de Defesa Nacional 
na Câmara dos Deputados, que debateu os reflexos da 
vitória de Fernando Lugo na eleição presidencial 
paraguaia. Uma das plataformas de campanha do ex-
bispo era a revisão do Tratado de Itaipu. Samek 
defendeu o diálogo com o novo presidente, mas 
rechaçou a possibilidade de alterar o tratado. 

Para ele, há várias formas de negociar sem 
precisar mexer na estrutura jurídica do acordo. Ao 
contrário do que diz Lugo, reafirmou que não há injustiça 
no texto. ‘Todo brasileiro tem de falar do tratado de 
cabeça erguida em qualquer lugar da galáxia. Ele é 
honesto, só quem não o conhece fala outra coisa’. 

Samek, no entanto, admitiu que o governo 
brasileiro precisa escutar as demandas do presidente 
Lugo para mostrar o que é possível fazer. E deu a 
entender que é possível fazer concessões.” 

(GONÇALVES, André, correspondente – Brasília. Jornal Gazeta do 

Povo). 

 

Leia o texto com atenção, para responder às questões de 
n.ºs 31 e 32: 
 
 
31. Ajuda do governo brasileiro ao Paraguai, segundo o 

texto: 
 

A) A valorização do real proporcionará três possíveis 
ajudas do governo brasileiro ao Paraguai: 1. fazer 
caixa; 2. auxiliar o vizinho; 3. reduzir a tarifa de 
energia do Brasil. 

B) A valorização do real proporcionará quatro 
possíveis ajudas do governo brasileiro ao 
Paraguai: 1. calcular o orçamento em dólar; 2. 
fazer caixa; 3. auxiliar o vizinho; 4. reduzir a tarifa 
de energia do Brasil. 

C) A valorização do real proporcionará duas 
possíveis ajudas do governo brasileiro ao 
Paraguai: 1. auxiliar o vizinho; 2. reduzir a tarifa 
de energia do Brasil. 

 

D) A valorização do real proporcionará uma possível 
ajuda do governo brasileiro ao Paraguai: 1. 
auxiliar o vizinho. 

E) A valorização do dólar proporcionará uma 
possível ajuda do governo brasileiro ao Paraguai: 
1. auxiliar o vizinho. 

 

32. Segundo o texto, o presidente Lugo: 
 

A) afirma que não há injustiça no texto do tratado. 
B) afirma que há injustiça no texto do tratado. 
C) afirma que ‘Todo brasileiro tem de falar do tratado 

de cabeça erguida em qualquer lugar da galáxia...’ 
D) deu a entender que é possível fazer concessões. 
E) afirma que o governo brasileiro precisa escutar as 

suas demandas. 
 

Considere o texto para responder às questões de n.ºs 33 e 
34.  
 
“Leilões de transmissão e geração, audiências e consultas 
públicas, e uma infinidade de ações da Agência Nacional 
de Energia Elétrica (ANEEL) despertam enorme interesse 
da sociedade. Para fazer frente a esta demanda, a ANEEL 
distribui textos em veículos de comunicação de todo o 
país com informações sobre a Agência. E também envia 
textos para as pessoas que se cadastram no seu site com 
interesses específicos no setor elétrico.” 

(Disponível em http://www.aneel.gov.br/area.cmf.?idarea=90.aCESSO em: 09 de 

maio de 2008). 

 
33. Podemos afirmar que: 
 

I- “Leilões de transmissão e geração,...”, a vírgula 
está separando um vocativo. 

II- O uso da vírgula após o verbo “despertam” é 
inaceitável, pois separaria o complemento do 
verbo “ enorme interesse da sociedade.”  

III- “Para fazer frente a esta demanda,” a vírgula está 
separando um aposto restritivo. 

 
Está CORRETA ou estão CORRETAS: 
 
A) Apenas I e II.  
B) Todas as afirmativas. 
C) Apenas II e III. 
D) Apenas I. 
E) Apenas II. 

 

34. Quanto às regras de acentuação, é CORRETO 
afirmar que existem no texto: 

 
A) 5 palavras proparoxítonas. 
B) 4 palavras paroxítonas. 
C) 5 palavras paroxítonas. 
D) 1 palavra oxítona. 
E) 3 palavras que contêm hiato. 
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35. Complete as lacunas CORRETAMENTE, observando 
a concordância verbal. 

 
“A Agência Nacional de Energia Elétrica (ANEEL) é 
administrada por uma diretoria colegiada, formada 
pelo diretor-geral e outros quatro diretores, entre eles, 
o diretor-ouvidor. As funções executivas da ANEEL 
________ a cargo de 20 superintendentes. Nas 
questões jurídicas, a Procuradoria Geral ________ a 
Agência. 
O diretor-geral ________ com o apoio do Gabinete, 
enquanto a diretoria ________ da estrutura de uma 
assessoria direta e da Secretaria Geral. A maioria das 
superintendências se ________ em questões técnicas 
– regulação, fiscalização, mediação e concessão – e 
uma parte delas se ________ à relação da ANEEL 
com seu público interno e a sociedade.” 
(Disponível em<http://www.aneel.gov.br/area.cfm.?idarea=6.Acesso em: 14 de 

maio de 2008). 

 
A) estão / representa / conta / dispõe / concentra / 

dedica. 
B) está / representa / contam /  dispõe / concentram / 

dedica. 
C) estão / representa / conta / dispõem / concentra / 

dedicam. 
D) estão / representa / contam / dispõem / concentra / 

dedica. 
E) está / representam / conta / dispõem / concentra / 

dedicam. 

 
TEXTO 

 
“Guerreiros araguaias, quereis saber qual foi o 

campeão que Tupã enviou a Jaguarê para dar-lhe o nome 
de guerra! 

“Ele aí está diante de vós. 
“É o grande Pojucan, o feroz matador de gente, 

chefe da tribo mais valente da poderosa nação dos 
Tocantins, senhores do grande rio. 

“Vós que o tendes aqui presente, vede como é 
terrível o seu aspecto, mas só eu que o pelejei conheço o 
seu valor no combate. 

“O tacape em sua mão possante é como o tronco 
do ubiratan que brotou no rochedo e cresceu. 

“Jaguarê, que arranca da terra o cedro gigante, 
não o pôde-arrancar de sua mão e foi obrigado a 
despedaçá-lo. 

“Os braços de Pojucan, quando ele os estende na 
luta, não há quem os vergue; são dois penedos que saem 
da terra. 

“Seu corpo é a serra que se levanta no vale. 
Nenhum homem, nem mesmo Camacan, o pode abalar. 

“Pojucan era o varão mais forte e o mais valente 
guerreiro que o sol tinha visto até aquele momento. 

“Foi este, guerreiros araguaias, o herói que 
ofereceu combate ao filho de Camacan; e Jaguarê 
aceitou, porque logo conheceu que havia encontrado um 
inimigo digno do seu valor. 

 

“Ele vos contempla, guerreiros araguaias. Se 
alguém duvida da palavra de Jaguarê e da força do 
guerreiro tocantim, chame-o a combate e saberá quem é 
Pojucan. 

(Disponível em<http://www.portaldacomunhao.com.br/livros/ubirajara.pdf). 

 

36. No texto de José de Alencar, são alguns exemplos de 
conectores de Coesão Textual por Antecipação, os 
seguintes: 
 
A) “o grande Pojucan” = o grande  – “é terrível o seu 

aspecto” = terrível – “o mais valente guerreiro” = 
valente . 

B) “Guerreiros araguaias” = Guerreiros  – “chefe da 
tribo” = chefe  – “o tacape em sua mão” = tacape .  

C) “quereis saber qual foi” = qual  – “Ele aí está” = 
Ele – “Nenhum homem” = Nenhum . 

D) “quereis saber qual foi” = foi  – “Tupã enviou a 
Jaguarê” = enviou  – “vede como é terrível o seu 
aspecto” = vede .  

E) “o grande Pojucan” = o – “não há quem os 
vergue” = os  – “Seu corpo é a serra” = a. 

 

37. Observe as orações: 
 

1.ª – “O rei que percebia do negócio começou a rir”. 
2.ª – “O rei, que percebia do negócio, começou a rir”. 
 
Assinale a alternativa CORRETA: 
 
A) As duas orações possuem o mesmo sentido. 
B) As duas orações só se diferenciam pelo uso da 

vírgula. 
C) Elas não se diferenciam, porque, nesse caso, o 

emprego da vírgula é opcional. 
D) A primeira tem sentido diferente da segunda: a 

primeira significa que pode haver dois reis, um 
que percebe do negócio e outro que não. 

E) A segunda tem sentido diferente da primeira: a 
segunda significa que só pode haver um rei e que 
esse rei percebe do negócio. 

 

38. Assinale a alternativa que NÃO corresponde à 
concordância nominal. 

 
A) A entrada de funcionários em usinas desativadas 

é proibida. 
B) É necessária a alteração nos valores das tarifas 

de energia elétrica. 
C) Ao criar o Banco de Informações de Geração 

(BIG), os responsáveis foram bastantes 
inteligentes. 

D) Os agentes que cuidam da segurança da energia 
fornecida estão alerta. 

E) O diretor-geral mandou uma carta aos consumi-
dores e em anexo informações muito importantes. 
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39. Observe a grafia CORRETA das palavras e preencha 
os espaços adequadamente. 
 
I- __________ a matriz energética brasileira é a 

mais renovável do mundo? 
II- A ANEEL possui uma equipe em __________. 
III- Os processos de Audiências e Consultas 

Públicas, ao longo de sua condução, contam com 
a realização de __________ públicas. 

IV- O Brasil utiliza 45% de fontes renováveis em suas 
matrizes. Isto é um __________. 

V- Conforme previsão do Plano Nacional, o Brasil 
chegará a 47% de fontes renováveis em suas 
matrizes, se não houver nenhum __________. 

 

A) Por que / ascensão / sessão / privilégio / 
empecilho. 

B) Porque / ascensão / seção / previlégio / 
empecilho. 

C) Por que / ascensão / sessão / previlégio / 
impecilho. 

D) Porque / ascenção / sessão / privilégio / 
empecilho. 

E) Porque / ascensão / sessão / previlégio / 
impecílio. 

 

40. Quanto ao uso do pronome demonstrativo, há ERRO 
na alternativa ou nas alternativas: 

 
I- Nesse dia, 15 de junho, estamos realizando o 

concurso da COPEL. 
II- Aqui, nesta sala, há pessoas atentas às questões 

da prova. 
III- Aquele fiscal, que está no corredor, desejou-nos 

boa sorte. 
 

A) Apenas I. 
B) Apenas II. 
C) Apenas III. 
D) Apenas I e III. 
E) Todas. 

 

  


